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Zusammenfassung

Gegenstand dieser Bachelorarbeit bildet die Rekonstruktion von digitalen Gletscher-
Höhenmodellen, basierend auf den Höheninformationen der Erstausgabe der Schweizer Lan-
deskarte 1:50 000. Die Arbeit fügt sich in ein Projekt der Versuchsanstalt für Wasserbau,
Hydrologie und Glaziologie VAW ein, im Zuge dessen bereits von vielen Gletschern Höhen-
modelle rekonstruiert wurden.

Im Gegensatz zur manuellen und punktweisen Digitalisierungsmethode der VAW kommt
in der vorliegenden Arbeit ein modifiziertes, halb-automatisches Verfahren zum Einsatz, das
auf der Höhenlinienextraktion sowie der Vektorisierung und Attribuierung der Höhenlinien
basiert.

Als Testgebiet für dieses Vorgehen dient der Glacier de Moiry in den Walliser Alpen, da von
der VAW bereits ein nach manueller Methode erstelltes digitales Höhenmodell (DHM) dieses
Gletschers vorliegt. Andreas Sidler hat in seiner Masterarbeit zusätzlich ein DHM mit
der modifizierten, halb-automatischen Vorgehensweise dieses Gletschers generiert. Aus diesen
Gründen ist es möglich, Vergleiche zwischen den beiden Methoden und den DHM der ver-
schiedenen Autoren anzustellen. Die Resultate zeigen für die beiden nach halb-automatischer
Methode generierten DHM eine mittlere Differenz unter einem Meter. Die Differenzen zum
DHM der VAW sind etwas grösser und betragen im Mittel wenige Meter.

Der ebenfalls in den Walliser Alpen gelegene Turtmanngletscher dient als weiteres Unter-
suchungsgebiet. Für das Projekt der VAW wird ein DHM dieses Gletschers mit dem halb-
automatischen Verfahren rekonstruiert, das danach mit dem aktuellen DHM25 von swisstopo
sowie einem DHM aus LIDAR-Daten verglichen wird. Die Resultate für die Höhendifferenzen
der DHM, die sich zeitlich um rund 60 beziehungsweise 70 Jahre unterscheiden, zeigen sich
so, wie sie im Grossen und Ganzen erwartet werden konnten. Im Mittel bewegen sich die
Differenzen im tiefen zweistelligen Meterbereich.
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ETH Zürich Kapitel 1. Einleitung

1. Einleitung

Das erste Kapitel gibt einen Überblick über die gesamte Bachelorarbeit. Die Einführung sowie
die zitierte Aufgabenstellung sollen einen angemessenen Einstieg in die Problemsituation und
diesen Bericht ermöglichen. Der Inhalt dieses Berichtes wird im letzten Abschnitt des Kapitels
kurz skizziert.

1.1. Einführung

Die Bachelorarbeit bildet gemäss dem Studienreglement 2003 den Abschluss des Bachelor-
studiums und ist für Studierende im 6. Semester obligatorisch. Sie dient den Studierenden
dazu, ihre Fähigkeiten zu selbstständiger und praxisorientierter Problemlösung sowie wissen-
schaftlichem Arbeiten zu fördern und einen Einblick in Themen einer Vertiefungsrichtung des
Masterstudiums zu erhalten. Für die Bachelorarbeit ist ein zeitlicher Aufwand von 250 bis
300 Arbeitsstunden vorgesehen.

Die vorliegende Arbeit findet ihren Ursprung in einem Projekt der VAW. Wissenschaftler
jenes Instituts haben bereits viele Gletscher der Schweiz aus Karten digitalisiert und model-
liert. Doch von ebenso vielen Gletschern fehlen die entsprechenden Daten. Daraus entstand
der Vorschlag, sich mit den Untersuchungsgebieten «Glacier de Moiry», «Turtmanngletscher»
und «Fieschergletscher» sowie mit einer weiteren Digitalisierungsmethode zu befassen. Diese
Arbeit befasst sich nur mit den ersten beiden Untersuchungsgebieten. Mit dem Fiescherglet-
scher, der im Vergleich zu den anderen beiden Gletschern deutlich grösser ist, beschäftigte
sich zeitgleich Andreas Sidler in seiner Masterarbeit.

Sowohl der Glacier de Moiry als auch der Turtmanngletscher befinden sich in den südöst-
lichen Walliser Alpen. Die genauen Lagen der beiden Gletscher sind der Abbildung 1.1 zu
entnehmen. Der in Abbildung 1.2 erkennbare Glacier de Moiry ist heute rund fünf Kilometer
lang und überdeckt eine Fläche von ebenso vielen Quadratkilometern. Das Ende der Gletscher-
zunge liegt auf rund 2400 m.ü.M., der höchste Punkt auf 3845 m.ü.M. Der Turtmanngletscher,
in Abbildung 1.3 gezeigt, ist ebenfalls rund fünf Kilometer lang, überdeckt aber mit 7,5 Qua-
dratkilometer eine deutlich grössere Fläche. Das Ende der Gletscherzunge liegt auf etwa 2240
m.ü.M. Der Höchstpunkt bildet das Bishorn auf 4150 m.ü.M. Im unteren Bereich mündet ein
Teil des Brunegggletschers, dessen Ursprung zwischen Bishorn und Brunegghorn liegt, in den
Turtmanngletscher. Im oberen Bereich sind Brunegg- und Turtmanngletscher durch den Fels-
grat des Stierbergs getrennt. Häufig zählt man den Brunegggletscher zum Turtmanngletscher

Roland Schenkel 1



ETH Zürich Kapitel 1. Einleitung

Abbildung 1.1.: Lage der beiden Untersuchungsgebiete in den Walliser Alpen (Relief und Ba-
siskarte: Bundesamt für Landestopografie, swisstopo).

Abbildung 1.2.: Glacier de Moiry, aufgenommen aus einem Motorsegler am 11. Oktober 2007
(Foto: Urs Bläsi).
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Abbildung 1.3.: Luftaufnahme des Turtmanngletschers vom 24. Oktober 2005 (Foto: Urs
Bläsi).

dazu, weshalb in dieser Arbeit mit dem Begriff «Turtmanngletscher» stets beide gemeint sind.
Weitere Gletscher in diesem Untersuchungsgebiet sind der Hängegletscher am Stierberg, der
Diablonsgletscher im Westen und der Pipjigletscher im Osten, die alle deutlich kleiner sind.

1.2. Aufgabenstellung

Die Aufgabenstellung in der Ausschreibung der Bachelorarbeit des IKG lautete wie folgt:
«Primäres Ziel ist es, anhand alter Karten die Höhenmodelle früherer Gletscherstände digi-

tal zu rekonstruieren und zu visualisieren. Dabei kommen halb- und vollautomatische Digitali-
sierungsverfahren zum Einsatz. Aus diesen Daten werden dann Höhenmodelle gerechnet, evtl.
Daten abgeleitet und anschliessend geeignet visualisiert. Weitere Datenquellen wie Luftbilder
können ebenfalls verwendet werden. Der Schwerpunkt kann dabei mehr auf die Digitalisie-
rungsverfahren (z.B. testen der in ArcGIS integrierten Toolbar ArcScan und vergleichen mit
anderen Verfahren) oder das Ausarbeiten verschiedener Visualisierungsmethoden gelegt wer-
den. In gemeinsamer Absprache werden Teilbereiche festgelegt, auf die fokussiert werden soll.
Weitergehende Schritte können ebenfalls integriert werden, je nach gewähltem Umfang der
Arbeit.» (IKG, Institut für Kartografie und Geoinformation, 2010)
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1.3. Ziele

1.3.1. Hauptziel

Primäres Ziel dieser Arbeit ist es, das Gebiet des Turtmanngletschers, basierend auf der
Erstausgabe der Schweizer Landeskarte 1:50 000 von 1941 beziehungsweise 1946, digital zu
rekonstruieren und zu visualisieren. Des Weiteren soll das resultierende DHM mit LIDAR-
Daten und dem DHM25, beides vom Bundesamt für Landestopografie swisstopo, verglichen
und die Differenzen visualisiert werden.

1.3.2. Teilziele

Ein erstes Teilziel ist die Bearbeitung des kleineren Untersuchungs- beziehungsweise Test-
gebietes des Glacier de Moiry. Die Bearbeitung des Gebietes beinhaltet die Farbseparation
der Landeskarte zur Extraktion der Höhenlinien, die Vektorisierung und deren Bereinigung
sowie die Attribuierung der Höhenlinien, die DHM-Interpolation und die Visualisierung des
DHM. Es sollen also die wesentlichen Arbeitsschritte zur Bearbeitung der gestellten Aufgabe
entwickelt und ein erstes Mal durchgeführt werden.
Für das Gebiet des Glacier de Moiry steht das, im Grundsatz nach gleicher Methode digi-

talisierte, DHM von Andreas Sidler, sowie das vollständig manuell digitalisierte DHM der
VAW zur Verfügung. So sind Vergleiche zwischen den zwei verschiedenen Digitalisierungsme-
thoden und den Arbeiten der zwei Autoren möglich, was ein zweites Teilziel darstellt.
Es folgen dieselben vier Bearbeitungsschritte für das Untersuchungsgebiet des Turtmannglet-

schers, die bereits für das Testgebiet «Glacier de Moiry» durchgeführt wurden. Darauf aufbau-
end erfolgen weitere Schritte, wie Vergleiche mit dem vorliegenden DHM25 und den LIDAR-
Daten des Turtmanngletschers und die etwas vertiefte Befassung mit der Visualisierung der
Resultate.

1.4. Abgrenzung

Der Schwerpunkt dieser Arbeit lag darin, das formulierte Hauptziel zu erreichen. Mit der
ArcScan-Toolbar in ESRI ArcGIS wurden einige Versuche durchgeführt, um eine optimale
Parameterwahl für die Vektorisierung zu eruieren. Vergleiche mit anderen Digitalisierungs-
verfahren wurden dabei aber nicht angestellt. Des Weiteren stellt das Ableiten von exakten,
glaziologischen Aussagen aus den Resultaten keinen Bestandteil der vorliegenden Bachelorar-
beit dar, sondern wird den entsprechenden Fachexperten überlassen.

1.5. Inhaltsübersicht

Im Kapitel 2 «Grundlagen» wird zuerst die Ausgangslage erläutert und die vorliegende Bache-
lorarbeit in den Kontext bereits abgeschlossener Arbeiten und veröffentlichter Publikationen
eingeordnet. Des Weiteren wird das der Arbeit zu Grunde liegende Datenmaterial aufgeführt,
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die verwendete Software aufgelistet und das grundsätzliche Konzept für das Vorgehen während
der Arbeit aufgezeigt. Das darauf folgenden Kapitel 3 «Vorgehen» beschreibt ausführlich den
während der Arbeit verfolgten Weg zur Zielerreichung und die dabei verwendeten Methoden.
Das Kapitel ist nach den wichtigsten Schritten gegliedert und beginnt daher mit den Ausfüh-
rungen zur Farbseparation. Darauf folgen die Abschnitte zur Vektorisierung, Attribuierung
und DHM-Generierung. Das Kapitel wird mit dem Abschnitt zur Visualisierung abgeschlossen.
Die Ergebnisse der Arbeit finden sich im Kapitel 4 «Resultate». Sie sind nach den zwei Unter-
suchungsgebieten «Glacier de Moiry» und «Turtmanngletscher» gegliedert. Schliesslich folgen
im Kapitel 5 «Schlussbemerkungen» nebst den Schlussfolgerungen die kritische Beurteilung
der Zielerreichung sowie ein Ausblick auf mögliche weitere Arbeiten in diesem Themengebiet.
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2. Grundlagen

Die folgenden fünf Abschnitte zeigen auf, wie sich die Ausgangslage zu Beginn der Arbeit
präsentierte, auf welchen Grundlagen die Arbeit abgestützt und wie sie konzeptionell aufge-
baut ist. Die Gliederung der ganzen Arbeit, vor allem aber des Kapitels 3 «Vorgehen», beruht
weitgehend auf den in Abschnitt 2.4 aufgeführten Etappen und Arbeitsschritten.

2.1. Ausgangslage und Kontext

Die Schweizer Alpengletscher stehen schon seit vielen Jahrzehnten im Fokus der Naturwis-
senschaften. Bereits in den Achtzigerjahren des 19. Jahrhunderts wurde in der Schweiz damit
begonnen, die Längenänderungen bestimmter Gletscher systematisch zu untersuchen (Aellen,
1995). Heute betreibt die Schweizerische Akademie der Naturwissenschaften SCNAT zusam-
men mit der VAW das Schweizerische Gletschermessnetz. Die Daten für den Glacier de Moiry
sind der Abbildung 2.1, die des Turtmanngletschers der Abbildung 2.2 zu entnehmen. Nebst
den Längenänderungen interessieren vor allem auch Massenbilanzen der Gletscher.

Abbildung 2.1.: Längenänderungen des Glacier de Moiry (SCNAT und VAW, 2010).

Eine Möglichkeit zur Bestimmung von Massenbilanzen ist das Vergleichen zweier Höhen-
modelle, welche die Gletscheroberfläche zu verschiedenen Zeiten repräsentieren (Huss et al.,
2008b,a; Bauder et al., 2007; Farinotti et al., 2009). Digitale Höhenmodelle von Gletschern
können durch Fernerkundungsmethoden, wie beispielsweise Laser Scanning oder Photogram-
metrie erzeugt werden (Baltsavias et al., 2001). Weitere Möglichkeiten stellen einerseits die
Geländeaufnahmen mit GNSS (Frey et al., 2008) sowie den klassischen Vermessungsmethoden
mit Tachymeter oder Nivellement (Orwatsch et al., 2001) dar. Andererseits können auch Hö-
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Abbildung 2.2.: Längenänderungen des Turtmanngletschers. Allein der Rückgang im Hitze-
sommer 2003 betrug über hundert Meter (SCNAT und VAW, 2010).

heninformationen von topografischen Karten genutzt und zu einem DHM aufbereitet werden
(Bauder et al., 2007). Die letzt genannte Variante steht im Zentrum dieser Arbeit. Die VAW
hat bis jetzt bereits rund zwanzig Gletscherhöhenmodelle aus alten topografischen Karten
erstellt und einige Untersuchungen damit durchgeführt (Bauder et al., 2007). Dabei wurden
die Höhenlinien punktweise und manuell digitalisiert. Das Ziel der vorliegenden Arbeit war es
daher, ein zumindest teilweise automatisiertes Verfahren zu testen und an den zwei konkre-
ten Beispielen des Glacier de Moiry und des Turtmanngletschers durchzuführen. Gleichzeitig
konnte so die Datengrundlage für weitere glaziologische Forschungstätigkeiten der VAW um
ein weiteres DHM des Glacier de Moiry und das DHM des Turtmanngletschers ergänzt wer-
den. In der gleichzeitig zu dieser Bachelorarbeit durchgeführten Masterarbeit von Andreas

Sidler wurde zudem ein weiteres DHM des Glacier de Moiry und ein DHM des Fiescherglet-
schers erzeugt. Ein drittes DHM mit der selben Datengrundlage des Glacier de Moiry war an
der VAW bereits vorhanden, was Vergleiche zwischen den zwei verschiedenen Vorgehensweisen
und den drei verschiedenen Resultaten zulässt.

2.2. Grundlagendaten und Koordinatensystem

2.2.1. Glacier de Moiry

Landeskarte 1946: Für das Untersuchungsgebiet Glacier de Moiry stand ein Farbscan der
Erstausgabe der Landeskarte 1:50 000 von swisstopo zur Verfügung. Es handelt sich
dabei um einen Ausschnitt des Kartenblattes 283 (siehe Abbildung 2.4) der Ausgabe von
1946 ohne Relief (siehe Tabelle 2.2). Der Gletscherstand des Glacier de Moiry datiert,
wie in Tabelle 2.1 erwähnt, höchstwahrscheinlich auf das Jahr 1932 (Mercanton, 1958).
Der in Abbildung A.1 im Anhang dargestellte RGB-Scan lag im TIF-Format mit einer
Bildgrösse von 2800 x 4000 Pixel, einer Auflösung von 72dpi und einer Dateigrösse von
knapp 35 MB vor. Der Kartenausschnitt war gemäss den Angaben in Tabelle 3.1 bereits
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georeferenziert.

Pixelkarte PK50: Ein identischer Ausschnitt aus dem Kartenblatt 283 war zudem aus der
aktuellen Pixelkarte 50 (PK50), der digitalen Landeskarte 1:50 000 von swisstopo vor-
handen. Auch diese Karte lag ohne Relief vor. Der Nachführungsstand für das Karten-
blatt 283 ist das Jahr 2001, wie der Abbildung 2.3 entnommen werden kann. Die RGB
TIF-Datei weist eine Bildgrösse von 2800 x 4000 Pixel auf, hat eine Auflösung von 72dpi
und eine Dateigrösse von 11.2 MB. Die Parameter der vorliegenden Georeferenzierung
können der Tabelle 3.1 entnommen werden.

DHM25: Ferner lag das DHM25 für das Gebiet des «Glacier de Moiry» vor. Dieses Ober-
flächenmodell beschreibt gemäss Hersteller swisstopo «die dreidimensionale Form der
Erdoberfläche ohne Bewuchs und Bebauung» (swisstopo, 2010a). Es basiert im Wesent-
lichen auf den Höheninformationen der Schweizer Landeskarte 1:25 000. Für den Glacier
de Moiry wurde die Kachel 1307 verwendet. Die Kacheleinteilung und Nummerierung ist
identisch mit jener der Schweizer Landeskarte 1:25 000. Angaben zum Stand der Daten
sind Tabelle 2.3 zu entnehmen.

DHM VAW: Das DHM der VAW basiert auf der oben erwähnten Landeskarte von 1946. Die
Digitalisierung erfolgte manuell durch punktweises Aufnehmen der Höhenlinien. Für die
Interpolation des DHM ist an der VAW der GTGRID 2.0 Algorithmus der Software
PV-WAVE von Visual Numerics Inc verwendet worden.

Abbildung 2.3.: Übersicht über den Nachführungsstand der Pixelkarte 50 (swisstopo, 2011b).
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Gletscher Stand
Moiry 1932

Turtmann 1931
Brunegg 1931
Diablons 1931
Pipji 1931

Tabelle 2.1.: Gletscherstände in der Erstausgabe der Schweizer Landeskarte 1:50 000 (Mercan-
ton, 1958).

2.2.2. Turtmanngletscher

Landeskarte 1941/1946: Als Grundlage für das Untersuchungsgebiet des Turtmanngletschers
diente ebenfalls ein RGB-Farbscan eines Ausschnittes der Erstausgabe der Landeskar-
te 1:50 000 ohne Relief von swisstopo. Das Gebiet des Turtmanngletschers ist auf den
vier Kartenblättern 273, 274, 283 und 284 abgebildet (siehe Abbildung 2.4). Die Blät-
ter 273 und 283 wurden 1946 herausgegeben, die Blätter 274 und 284 im Jahr 1941.
Eine Übersicht findet sich in Tabelle 2.2. Der Gletscherstand des Turtmanngletschers
datiert höchstwahrscheinlich auf das Jahr 1931 (siehe Tabelle 2.1). Das im TIF-Format
vorliegende Bild, in Abbildung A.3 im Anhang als Übersicht gezeigt, besteht daher
aus vier zusammengesetzten Scans der genannten vier Kartenblättern. Es liegt in einer
Bildgrösse von 2800 x 3600 Pixel, einer Auflösung von 72dpi und einer Dateigrösse von
rund 18 MB vor. Die Datei war bereits mit den in Tabelle 3.1 angegebenen Parameter
georeferenziert.

Pixelkarte PK50: Auch hier stand der selbe Kartenausschnitt aus der PK50 zur Verfügung.
Der Nachführungsstand ist gemäss Abbildung 2.3 das Jahr 2004 für das Blatt 273, 2005
für das Blatt 274 und 2001 für die Blätter 283 und 284. Die 10 MB grosse RGB TIF-
Datei weist eine Bildgrösse von 2800 x 3600 Pixel und eine Auflösung von 72dpi auf.
Der Kartenausschnitt war gemäss den Angaben in Tabelle 3.1 bereits georeferenziert.

LIDAR: Für das Gebiet waren ebenfalls LIDAR-Rohdaten aus einer Befliegung von swisstopo
anno 2005 mit einer Dateigrösse von knapp 300 MB vorhanden. Es handelt sich dabei
um Daten der Kacheln 1307-42, 1307-44, 1308-31, 1308-33, 1327-22, 1327-24, 1328-11,
1328-13. Die ersten vier Ziffern der Nummern stehen für das entsprechende Kartenblatt
der Schweizer Landeskarte 1:25 000. Die Systematik der letzten beiden Ziffern ist der
Abbildung 2.5 zu entnehmen.

DHM25: Weitere Grundlagendaten für dieses Untersuchungsgebiet lagen in Form des digita-
len Oberflächenmodells DHM25 vor. Genauere Angaben sind in der Tabelle 2.3 aufge-
führt.

Orthophoto: Auch Orthophotos aus SWISSIMAGE von swisstopo standen für die Visuali-
sierung zur Verfügung. Diese weisen eine Bodenauflösung von einem halben Meter auf.
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Es handelt sich um georeferenzierte 8-Bit RGB TIFF-Dateien mit einer Grösse von
insgesamt rund 1.3 GB. Verwendet wurden die selben acht Kacheln wie bei den LIDAR-
Daten. Die Aufnahmedaten sind der Tabelle 2.4 zu entnehmen.

Abbildung 2.4.: Blattübersicht der Schweizer Landeskarte 1:50 000, gelb getönt die vier Blätter
für das Untersuchungsgebiet «Turtmanngletscher», orange gestreift das Blatt
für das Gebiet «Glacier de Moiry» (nach swisstopo, 2011a).

Abbildung 2.5.: Quadtree-Systematik der Kachelnummerierung am Beispiel des Kartenblattes
1307.

Blatt 273 274 283 284
Aufnahme 1925-1939 1928-1936 1931-1938 1929-1937

Nachführung - 1941 - 1941
Ausgabe 1946 1941 1946 1941

Tabelle 2.2.: Übersicht der relevanten Zeitangaben zu den verwendeten Blättern der Erstaus-
gabe der Schweizer Landeskarte 1:50 000 gemäss Kartenrandangaben.
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Kachel 1307 1308 1327 1328
Höhenkurven (ohne Gletscher) 1986 1981 1988 1982
Einzelkoten 1985 1981 1983 1982
Höhenkurven auf Gletschern 1992 1993 1995 1995
Bruchkanten 1994 1994 - -

Tabelle 2.3.: Stand der Daten, die für das DHM25 von swisstopo verwendet wurden (swissto-
po, 2005).

Kachel Aufnahmedatum
1307-42 2008
1307-44 2008
1308-31 2008
1308-33 2008
1327-22 2007
1327-24 2006
1328-11 2008
1328-13 2006

Tabelle 2.4.: Aufnahmedaten der Orthophotokacheln.

2.2.3. Genauigkeiten

Landeskarten: Für die erste Generation der Schweizer Landeskarten im Massstab 1:50 000
wurde ein zulässiger mittlerer Höhenfehler von mH = ± [1.5 + 10 · tan (α)] Meter und
ein zulässiger mittlerer Lagefehler vonmL = ± [10 + 1.5 · cot (α)] Meter festgelegt (Bert-
schmann, 1957). Der Vollständigkeit halber seien hier auch noch die Formeln für die
Schweizer Landeskarte im Massstab 1:25 000 genannt: mH = ± [1 + 7 · tan (α)] Meter
und mL = ± [7 + cot (α)] Meter (Bertschmann, 1957). Die Graphen der Höhenfehler-
funktionen sind in Abbildung 2.6 dargestellt. Untersuchungen von Bertschmann (1957)
zeigten aber am Beispiel des Kartenblattes «Rocher de Naye 1:50 000», dass die Genau-
igkeiten zumeist deutlich besser als die festgelegten Toleranzen waren. Heute darf bei
den Landeskarten 1:50 000 von einem Lagefehler von 5 bis 15 Meter ausgegangen werden
(swisstopo, 2010c).

DHM25: Der mittlere Fehler in der Höhe bewegt sich nach Angaben von swisstopo in den
Alpen im Allgemeinen zwischen etwa drei und acht Meter (swisstopo, 2010a). Für das
Gebiet des Glacier de Moiry wurde die Kachel 1327, für den Turtmanngletscher zusätz-
lich die Kacheln 1307, 1308 und 1328 verwendet. Die Genauigkeitsschätzungen für diese
Kacheln können der nachfolgenden Tabelle 2.5 entnommen werden.

LIDAR: Spezifische Angaben zur Genauigkeit der LIDAR-Rohdaten liegen nicht vor. Sie dürf-
te sich aber in einem vergleichbaren Rahmen wie die Genauigkeit des digitalen Terrain-
modells der Amtlichen Vermessung DTM-AV bewegen. Die einfache Standardabwei-
chung der Höhe wird für das DTM-AV mit 0.5 Meter angegeben (swisstopo, 2010b).
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Orthophoto: Die Standardabweichung für die Lagegenauigkeit in unebenem Gelände beträgt
± 3 bis 5 Meter (swisstopo, 2011c).
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Abbildung 2.6.: Plot der Toleranzformeln für die Höhenfehler. Blau für die Landeskarte
1:50 000, rot für die Landeskarte 1:25 000.

Kachel 1307 1308 1327 1328
Genauigkeit [m] 3-4 4-6 4-6 6-8

Tabelle 2.5.: Genauigkeitsschätzung (mittlere Abweichung des Matrixmodells an den Einzel-
koten des Basismodells) der verwendeten DHM25-Kacheln (swisstopo, 2005).

2.2.4. Koordinatensystem

Die Arbeiten in ESRI ArcGIS erfolgten sowohl für den Glacier de Moiry als auch den Turt-
manngletscher im Schweizerischen Bezugssystem CH1903 mit dem Fundamentalpunkt in der
alten Sternwarte Bern, dem Bezugsellipsoid nach Bessel von 1841 und dem Referenzrahmen
der Landesvermessung 1903, kurz LV03. Ausgangspunkt für die Höhen ist der «neue Hori-
zont» des «Repère Pierre du Niton» mit 373.6 Meter über Meer. Das Kartenmaterial bezieht
sich ebenfalls auf CH1903 und LV03. Die verwendete Einheit in ArcGIS war dementsprechend
das Meter.
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2.3. Software

Zur Lösung der gestellten Aufgabe wurde folgende Software verwendet:

• Bildbearbeitung:

– Adobe, Photoshop CS4 Version 11.0.2

– Adobe, Illustrator CS4 Version 14.0.0

– MathWorks, Matlab, Version 7.9.0.529 (R2009b)

• GIS:

– ESRI, ArcGIS, Version 10.0, Service Pack 1

• 3D Visualisierung:

– ESRI, ArcGIS, Version 10.0, Service Pack 1

– Right Hemisphere, Deep Exploration, Version 5.7, CAD Edition, Trial Version

– Adobe, Acrobat Pro X Version 10.0.3

• Textverarbeitung

– LATEX der TEXLive2010-Distribution, unter Verwendung von

∗ LYX Version 2.0.0

∗ KOMA-Script Klassen

2.4. Konzept und Überblick

Die Ausarbeitung des Konzepts für die Bearbeitung der vorliegenden Bachelorarbeit wurde in
der dritten Semesterwoche abgeschlossen. Es sah vor, die Arbeit in vier Etappen zu gliedern.

2.4.1. Etappen

• 1. Etappe: Ausgabe der Arbeit und Konzeption
Die erste Etappe beinhaltet die Ausgabe der Arbeit, Vorbesprechungen mit Samuel

Wiesmann, Andreas Bauder und Andreas Sidler sowie die gesamte Konzeptpha-
se. Spätestens in der dritten Semesterwoche sollte diese Etappe abgeschlossen sein.

• 2. Etappe: Bearbeitung Testgebiet «Glacier de Moiry»
In der zweiten Etappe geht es darum, die ersten vier Arbeitsschritte (siehe unten) für das
etwas kleinere Testgebiet des «Glacier de Moiry», oder zumindest Teile davon, durchzu-
führen. Der Schwerpunkt wird auf Schritt 1 gelegt. Es soll ein möglichst gutes Verfahren
zur Höhenlinienextraktion gefunden und entweder als Matlab-Programm oder als Anlei-
tung für Photoshop oder Matlab festgehalten werden. Die Resultate des DHM werden
mit jenen von Andreas Sidler verglichen.
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• 3. Etappe: Bearbeitung Untersuchungsgebiet «Turtmanngletscher»
Diese Etappe bildet das eigentliche Kernstück dieser Bachelorarbeit. Für das Unter-
suchungsgebiet «Turtmanngletscher» werden wiederum die unten genannten sechs Ar-
beitsschritte durchgeführt. Erkenntnisse aus der zweiten Etappe werden berücksichtigt.
Besonders Schritt 1 sollte im Vergleich zur zweiten Etappe deutlich weniger Zeit in An-
spruch nehmen. Der Schwerpunkt dieser Etappe liegt bei der Visualisierung sowohl des
DHM als auch der Vergleiche mit den LIDAR-Daten und dem DHM25.

• 4. Etappe: Zusammentragen der Resultate und Abschluss der Arbeit
In der letzten Etappe werden die Erkenntnisse und Resultate zusammengetragen und
analysiert. Am Bericht wird bereits während den Etappen zwei und drei gearbeitet.
In der vierten Etappe soll aber genügend Zeit für Layout und Abschluss des Berichts
bleiben. Die Ausarbeitung der Präsentation und des Posters bildet, nebst dem Zusam-
menstellen aller Dateien zur Abgabe auf CD, den Abschluss der Arbeit.

2.4.2. Arbeitsschritte

Die oben genannten Arbeitsschritte wurden im Konzept wie folgt festgehalten:

• Schritt 1: Bildbearbeitung und Extraktion der Höhenlinien
Den erste Schritt bilden die Bildbearbeitung der Kartenscans und die Extraktion der
Höhenlinien der Untersuchungsgebiete. Dazu soll neben Photoshop vor allem auch mit
Matlab versucht werden, die Höhenlinien zu extrahieren. Als Resultat sollen diese in
einem Binärbild vorliegen.

• Schritt 2: Vektorisierung, Bereinigung und Attribuierung
Das Binärbild der Höhenlinien wird mir ArcGIS vektorisiert. Die Höhenkurven gleicher
Höhen werden verbunden und allfällige fehlerhafte Objekte bereinigt. Danach wird den
Höhenlinien ihre Höhe zugewiesen.

• Schritt 3: DHM Interpolation
Durch die Höhenlinien wird ein DHM interpoliert. Dabei sollen verschiedene Interpola-
tionsalgorithmen zum Einsatz kommen sowie die Parameter des DHM variiert werden
(TIN / Raster, Maschenweite, etc.).

• Schritt 4: Visualisierung des DHM
Die verschiedenen Resultate für die DHM sollen möglichst ansprechend und zweckmässig
visualisiert werden. Verschiedene Varianten sollen ausprobiert werden.

• Schritt 5: Vergleich DHM mit LIDAR und DHM25
Da für das Gebiet «Turtmanngletscher» sowohl LIDAR-Daten als auch das DHM25
vorliegen, sollen Vergleiche mit beiden Datensätzen gemacht werden.

• Schritt 6: Visualisierung der Vergleiche
Die Differenzen zwischen dem erzeugten DHM, den LIDAR-Daten und dem DHM25
sollen möglichst ansprechend und zweckmässig visualisiert werden
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2.4.3. Roadmap

Im Laufe der Konzeptionierung der Bachelorarbeit wurde auch ein grober Zeitplan erarbeitet,
der wie folgt ausgesehen hat und weitgehend befolgt wurde.

Semesterwoche Etappe Inhalt
1 1 Ausgabe und

2 - Konzeption der Arbeit

3 1 / 2 Bearbeitung des Testgebietes

4 2 «Glacier de Moiry» und

5 2 Durchlaufen der Schritte 1 bis 4

6 3

7 3 Bearbeitung des Untersuchungsgebietes

8 3 «Turtmanngletscher» bis und mit Schritt 3

9 3

Osterferien

10 3 Durchlaufen der Schritte 4 bis 6

11 3 für das Untersuchungsgebiet

12 3 «Turtmanngletscher»

13 4 Zusammentragen der Resultate, Ausarbeitung

14 4 der Präsentation, des Berichtes, des Posters und

- 4 der abzugebenden CD

Tabelle 2.6.: Für die Arbeit verwendeter Zeitplan.
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3. Vorgehen

Dieses Kapitel widmet sich ausführlich der Dokumentation des Vorgehens zur Zielerreichung
der gestellten Aufgabe. Der Aufbau des Kapitels entspricht der Chronologie der Bearbeitungs-
schritte während des Semesters und zeigt den vollständigen Weg, um von den Grundlagenda-
ten bis zu den Resultaten zu gelangen.

3.1. Farbseparation und Höhenlinienextraktion

Das Ziel des ersten Schrittes war es, die Höhenlinien aus den Farb-Scans der Schweizer Lan-
deskarte zu extrahieren. In einem ersten Ansatz wurde versucht, mittels Kantenextraktion
in Mathworks Matlab dieses Ziel zu erreichen. Der zweite Ansatz basiert auf der Idee der
Farbseparation. Im vorhandenen Kartenmaterial liegen die Höhenlinien in drei Farben vor:
schwarz in felsigen Bereichen, blau auf den Gletschern und braun in den übrigen Gebieten.
Separiert man die entsprechenden Farben, erhält man je ein neues Bild, das im Wesentlichen
nur noch die Höhenlinien enthält.

3.1.1. Mit Mathworks Matlab

Auf Grund von Erfahrungen mit der Image Processing Toolbox von Matlab, die im Zuge der
Lehrveranstaltung Photogrammetrie Grundzüge im 4. Semester gemacht wurden, bestand die
Idee, die Farbseparation auch in Matlab zu versuchen. Die Software Matlab von Mathworks ist
eine auf Matrizenrechnen (MATrix LABoratory) spezialisierte Software, die ihren Ursprung
an der University of New Mexico UNM hat. Sie eignet sich daher zur Bearbeitung und Pro-
zessierung von Rasterbildern, ist aber für diese Zwecke deutlich weniger benutzerfreundlich
ausgelegt als spezialisierte Bildbearbeitungsprogramme wie beispielsweise Adobe Photoshop.
Matlab bietet verschiedene Kanten-Filter und Operatoren, mit denen zuerst einige Versuche

gemacht wurden. Allen gemeinsam ist, dass sie nur mit Grauwertbildern arbeiten können. Zu
erwähnen sind hier die einfacheren Gradienten-Filter wie Sobel, Prewitt und Roberts. Zur
grundlegenden Funktionsweise von Filtern in der Bildverarbeitung sei auf die diesbezügliche
Literatur, zum Beispiel «Mathematische Bildverarbeitung: Einführung in Grundlagen und
moderne Theorie» von Bredies und Lorenz (2010), verwiesen.
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Gx =

 −1 0 +1
−1 0 +1
−1 0 +1

 Gy =

 −1 −1 −1
0 0 0

+1 +1 +1


Abbildung 3.1.: Grundstruktur eines Gradienten-Operators am Beispiel von Prewitt (Albertz

und Wiggenhagen, 2008).

Durch Kombination der Operatoren in x- und y-Richtung erhält man die Gradientengrösse
oder Kantenstärke zu G =

√
G2

x +G2
y und die Kantenrichtung Θ = arctan

(
Gy

Gx

)
. Die Opera-

toren nach Roberts und Sobel sind analog aufgebaut. Beim Roberts-Operator findet jedoch
lediglich eine ungewichtete 2x2-Faltungsmatrix Anwendung, wogegen beim Sobel-Operator
im Vergleich zum Prewitt-Operator die Grauwerte zusätzlich gewichtet werden (Albertz und
Wiggenhagen, 2008).
Ein weiterer Filter, der in Matlab zur Verfügung steht, ist der Laplacian of Gaussian (LoG)
Operator. Dabei werden die zweiten Ableitungen in den orthogonalen Richtungen x und y
gebildet. Bei Kanten resultiert dabei der Wert 0. Da die zweiten Ableitungen, ausgedrückt
durch den Laplace-Operator, sehr rauschanfällig sind, wird das Bild vorgängig mit einem
Gauss-Filter geglättet (Petrou und Petrou, 2010). Dies erklärt auch den Namen des Opera-
tors. Durch die Glättung und die diskreten Werte eines Raster-Bildes wird der exakte Wert
Null nur selten berechnet. Daher werden Nulldurchgänge, also Vorzeichenwechsel, als Kanten
gewertet.
Des Weiteren steht in Matalb der Algorithmus nach Canny (1986) zur Verfügung, mit

dem einige Versuche unternommen wurden. Dieser Kantendetektor arbeitet in vier Schritten
(Albertz und Wiggenhagen, 2008):

1. Das Bild wird mit einem Gauss-Filter geglättet, um das Rauschen zu unterdrücken.

2. Die Kantenstärke G und die Kantenrichtung Θ werden für jedes Pixel mittels einem
Gradienten-Filter berechnet

3. Non-Maxima Unterdrückung: Es wird sichergestellt, dass eine Kante nur ein Pixel breit
ist, in dem das Resultat aus Schritt 2 auf lokale Maximas untersucht wird. Ist ein Pixel
im Bezug zu seinen acht Nachbarpixeln kein Maximum, so wird es auf Null gesetzt,
ausser es liegt in der berechneten Kantenrichtung.

4. Schwellwert-Hysterese: Die aus Schritt drei entstandenen Pixel eines Grauwertbildes
werden mittels zweier Schwellwerte klassifiziert. Starke Pixel werden unter Kombination
mit schwachen Pixeln zu Kanten verknüpft.

Die Versuche mit den genannten Operatoren und Algorithmen waren allesamt nicht sehr er-
folgreich. Dies liegt daran, dass die Höhenlinien in den Bildern deutlich breiter als ein Pixel
sind. Durch Verwendung eines Kantendetektors erhält man folglich für jede Höhenlinie zwei
Kanten. Möglicherweise würde sich das Resultat der Kantendetektion zu einem geeigneten
Endprodukt weiter verarbeiten lassen. Dieser Ansatz wurde aber aus Zeitmangel nicht weiter
verfolgt. Stattdessen entstand durch einiges, eher unsystematisches Probieren, der folgende
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kleine Algorithmus. Dieser erreicht immerhin, dass die Höhenlinien stärker vom übrigen Bild-
inhalt abgegrenzt und ihre Farben stark homogenisiert werden.

I=imread(’input_filename.tif’);

HSV=rgb2hsv(I);

V=HSV(:,:,3);

BW=edge(V,’log’);

G=V+BW;

imwrite(G,’output_filename.tif’)

Dabei wird das Bild «input_filename.tif » zuerst eingelesen und in den HSV-Farbraum
(Hue: Farbton, Saturation: Sättigung, Value: Hellwert) transformiert. Der Value-Kanal wird
mit einem LoG-Kantendetektor bearbeitet und mit sich selbst addiert, worauf das Resultat als
«output_filename.tif» gespeichert wird. Das Resultat des Algorithmus ist an einem kleinen
Beispiel in Abbildung 3.2 zu sehen.

Abbildung 3.2.: Kartenausschnitt vor (links) und nach der Prozessierung mit dem genannten
Algorithmus.

Durch diese Verarbeitung ist es mit Adobe Photoshop einfacher möglich, gezielt Höhenli-
nien zu selektieren. Doch es zeigte sich, dass vergleichbare Resultate in derselben oder sogar
kürzeren Zeit auch direkt in Adobe Photoshop erreicht werden können.

3.1.2. Mit Adobe Photoshop

Ein Vorschlag für das Vorgehen mit Adobe Photoshop, der Bildbearbeitungssoftware schlecht-
hin, wurde bereits zu Beginn des Semesters von Janett Hanitzsch, Praktikantin am IKG,
unterbreitet. Darauf aufbauend wurde das hier dokumentierte Vorgehen entwickelt.
Für die Isolation der blauen Höhenlinien wurde wie folgt vorgegangen. Mit dem Color Ran-

ge Tool (→ Select → Color Range) wird die schwarze Farbe unter hoher Unschärfe (Fuzziness)
ausgewählt. Durch die hohe Unschärfe werden auch gleich weitere dunklere Bildbereich se-
lektiert, die für die Separation der blauen Höhenlinien unerwünscht sind. Die so selektierten
Bildbereiche, vor allem schwarze Höhenlinien, Felsen und Beschriftung, können gelöscht wer-
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Abbildung 3.3.: Black and White Tool mit den gewählten Einstellungen für die blauen (links),
die braunen (mitte) und schwarzen (rechts) Höhenlinien.

den. Sie wären bei der Anwendung des Black and White Tools störend. Mit dem genannten
Tool (→ Image → Adjustments → Black and White) wird nun bestimmt, welche Farben neu
schwarz oder weiss werden. Die genauen Einstellungen können der Abbildung 3.3 entnommen
werden. Die gewünschten, vormals blauen Höhenlinien sind nun schwarz gefärbt. Weiterhin
sind aber ungewünschte Bereiche vorhanden, die grau bis dunkelgrau gefärbt sind. Diese wer-
den entfernt, in dem mit dem Color Range Tool wiederum die schwarze Farbe selektiert wird,
nun aber mit tiefer Unschärfe, um wirklich nur die Höhenlinien zu selektieren. Mit der In-
vertierung der getätigten Selektion ist mit einem Klick, abgesehen von den Gewässern und
Gletscherstrukturen, vieles markiert, was nicht weiter erwünscht ist. Diese Bereiche können
gelöscht werden. Die noch bestehenden Objekte, die keine Höhenlinien darstellen, sollten so-
weit als möglich bereits zu diesem Zeitpunkt entfernt werden. Das Resultat, am Beispiel der
blauen Höhenlinien in Abbildung 3.4 gezeigt, kann nun als Grauwertbild (→ Image → Mode
→ Greyscale) gespeichert und für die Vektorisierung verwendet werden.
Für die braunen Höhenlinien wird grundsätzlich analog vorgegangen, wobei die Einstellun-

gen für die Bearbeitung mit dem Black and White Tool natürlich, wie in Abbildung 3.3 zu
sehen, entsprechend angepasst werden. Auch für die schwarzen Höhenlinien wird am Anfang
mit dem Color Range Selection Tool der schwarze Bereich mit hoher Unschärfe selektiert.
Die Auswahl wird aber umgekehrt, damit die Bereiche gelöscht werden können, die eindeutig
nicht schwarz gefärbt sind. Um das Resultat zu verbessern wird auch im Falle der schwarzen
Höhenlinien das Black and White Tool und zum Schluss ein weiteres Mal, analog zu den
anderen Farben, das Color Range Tool verwendet.

3.2. Vektorisierung

Im zweiten Schritt wurden die in Schritt Eins generierten Rasterdaten mit Hilfe der ArcScan-
Toolbar von ESRI ArcGIS vektorisiert. Die verwendeten Parameter und deren Werte werden
im Unterabschnitt 3.2.2 aufgeführt. Angaben zu möglichen Schwierigkeiten bei der Vektori-
sierung finden sich im Unterabschnitt 3.2.3.
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Abbildung 3.4.: Die blauen Objekte, namentlich blaue Höhenlinien, Gletscherstrukturen und
Gewässer des Ausgangsbildes (links), werden separiert (rechts).

3.2.1. Vektorisierung mit ESRI ArcGIS

Für die Vektorisierung muss zuerst das durch die Farbseparation entstandene Bild in ArcMap
importiert werden. Einfachheitshalber können gleich alle drei Grauwertbilder importiert wer-
den, die nach der Farbseparation vorhanden sind. Dabei ist zu beachten, dass für jedes der drei
Bilder die Georeferenzierung in Form eines TIFF-World-Files (TFW) vorliegt. Diesem muss,
abgesehen von der Dateiendung, der gleiche Namen wie dem dazugehörigen Bild gegeben wer-
den. Da während der Bildbearbeitung die Bildgrösse nicht verändert und der Bildinhalt nicht
verschoben wurde, erhalten alle Bilder die selben Georeferenzierungsparameter, die in Tabelle
3.1 festgehalten sind.

Parameter Werte «Glacier de Moiry» Werte «Turtmanngletscher»
A 2.5000000000 2.5000000000
D 0.0000000000 0.0000000000
B 0.0000000000 0.0000000000
E -2.5000000000 -2.5000000000
C 608001.2500000000 617001.2500000000
F 109001.2500000000 114998.7500000000

Tabelle 3.1.: Parameter der Georeferenzierung für Bilddateien der beiden
Untersuchungsgebiete.

Dies sind die Parameter einer Affintransformation, die in ESRI ArcGIS «Image-to-World
Transformation» genannt wird. Die Transformation unterliegt den folgenden Abbildungsglei-
chungen:

X = Ax+By + C

Y = Dx+ Ey + F
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Dabei sind X und Y die berechneten Landeskoordinaten des Pixelzentrums vom Pixel
Pi(xi/yi). Die Pixelkoordinaten x und y beschreiben also die Position eines Pixels im Bild,
die Koordinaten X und Y die Position des selben Pixels im globalen Koordinatensystem (hier
CH1903 LV03). Die Parameter A und E sind die Skalierungen in der gewählten Einheit in x-
und y-Richtung. Mit B und D wird eine allfällige Rotation beschrieben und die Parameter C
und F beschreiben schliesslich die Translation des Zentrums des obersten linken Pixels (ES-
RI, 2011d). Im vorliegenden Fall ist die gewählte Einheit das Meter, die Parameter C und F
beschreiben somit die Position in Schweizer Landeskoordinaten.
Sind die drei Bilder importiert, kann ihre Darstellungsart auf «classified» (→ Layer Pro-

perties → Symbology → Show: Classified) geändert werden, womit man bei einer Anzahl von
zwei Klassen ein Binärbild erhält. Bevor mit der eigentlichen Vektorisierung begonnen werden
kann, müssen in ArcCatalog leere Shape-Files erstellt werden. Diese sind vom Feature Type
«Polyline» und erhalten als Spatial Reference das CH1903 LV03. Es wurden drei Shape-Files,
also eines für jede Höhenlinienfarbe, erstellt. Diese leeren Shape-Files sind nötig, um die Daten
aus der Vektorisierung darin speichern zu können.
Die Vektorisierung geschieht unter Verwendung der ArcScan Toolbar. Das zu vektorisieren-

de Rasterbild wird ausgewählt. In der Toolbar können die gewünschten Einstellungen vorge-
nommen (→ ArcScan Toolbar → Vectorization → Vectorization Settings) und die Vektorisie-
rung gestartet werden.

3.2.2. Verwendete Parameter

Abbildung 3.5 zeigt das Eingabefenster zur Wahl der Parameter für die Vektorisierung. Die
Optionen haben folgende Eigenschaften und Einflüsse auf die Vektorisierung (ESRI, 2011b).

• Intersection Solution: Diese Option bestimmt, wo der Schnittpunkt sich kreuzender Li-
nien zu liegen kommen soll. Wählbar sind «geometrisch», «median» oder «keine».

• Maximum Line Width: Damit wird die maximale Breite der zu vekotrisierenden Linien
bestimmt.

• Noise Level: Bei tiefem «Noice Level» werden auch kleine, möglicherweise unerwünschte
Strukturen vektorisiert. Ein hohes «Noise Level» unterdrückt dies und vektorisiert nur
die groben Strukturen.

• Compression Tolerance: Bestimmt die Dichte der Stützpunkte.

• Smoothing Weight: Gibt an, wie stark die aus der Vektorisierung resultierenden Linien
geglättet werden.

• Gap Closure Tolerance: Diese Einstellung dient der Angabe, wie gross Lücken einer Linie
sein dürfen, ohne dass die Linie unterbrochen wird.

• Fan Angle: Gibt den Suchwinkel bei einer Lücke an, in dem eine allfällige Fortsetzung
gesucht wird.
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• Hole Size: Diese Grösse bestimmt, wie gross «Löcher» in den Linien maximal sein dürfen,
damit sie noch ignoriert werden. Löcher sind einzelne Pixel, die vollständig von Pixeln
in der Linienfarbe umgeben sind.

• Resolve Corners: Hier wird angegeben, wie mit Ecken umgegangen werden soll. Entweder
wird die Vektorisierung an Ecken einfach fortgeführt, wobei die Ecke leicht abgerundet
wird, oder die Vektorisierung wird angehalten und neu gestartet. Die Ecke wird dann
kantig. Wird diese Option gewählt, kann auch ein «Maximum Angle» angegeben werden,
für den eine Ecke gesetzt wird.

Einige vordefinierte Einstellungen für charakteristische Situationen können auch direkt ausge-
wählt werden (→ ArcScan Toolbar → Vectorization→ Vectorization Settings→ Styles). Nebst
«Polygons», «Parcels» und «Outline» kann hier die Option «Contours» gewählt werden. Die-
se Voreinstellungen waren ein guter Anhaltspunkt, um einige Versuche mit unterschiedlicher
Parameterwahl durchzuführen. Die schliesslich für die Vektorisierung gewählten Parameter
können der Abbildung 3.5 entnommen werden. Für alle drei Höhenlinienfarben wurden die
selben Parameter verwendet.

Abbildung 3.5.: Einstellungen für die Vektorisierung, hier im Bild für die blauen Höhenlinien
des Turtmanngletschers.

3.2.3. Mögliche Probleme und Bereinigung

Für die Vektorisierung der Höhenlinien waren die «Maximum Line Width»- und die «Gap
Closure Tolerance»-Einstellung von gewisser Bedeutung. Wird die maximale Breite der Linien
zu tief gewählt, kann es bei dickeren Linien passieren, dass daraus nicht eine, sondern mehrere
Linien oder kleine Schleifen erstellt werden. Abbildung 3.6 zeigt diesen Effekt am Beispiel einer
braunen Höhenlinie im Gebiet des Turtmanngletschers.
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Abbildung 3.6.: Effekt, der bei zu tiefer Maximum Line Width auftreten kann.

Die «Gap Closure Tolerance» darf einerseits nicht zu tief gewählt werden, weil sonst bereits
kleine Lücken reichen, um eine Unterbrechung der Linie hervorzurufen. Damit verbunden sind
oft Ablenkungen an den Enden der gebildeten Linien, wie sie in Abbildung 3.7 zu erkennen
sind. Andererseits verursacht eine zu hohe «Gap Closure Tolerance», dass Verbindungen zu
anderen Höhenlinien gemacht werden, die unerwünscht sind. Eine perfekte Einstellung, die
beide genannten Ansprüche vollumfänglich erfüllt, konnte nicht ermittelt werden. Abbildung
3.5 zeigt die für diesen Parameter gewählte Grösse von 10 Pixeln, die einen Kompromiss zur
Erfüllung beider Forderungen darstellt.

Abbildung 3.7.: Unterbrechung und Ablenkungen an den Enden der vektorisierten Höhenlini-
en wegen einer kreuzenden, anders farbigen Linie.

Eine weitere Schwierigkeit ist, dass bei der Vektorisierung selbstverständlich nicht zwischen
Höhenlinien und anderen Bildinhalten unterschieden wird. Auch wenn bereits bei der Farbse-
parierung darauf geachtet wurde, unerwünschte Bildinhalte möglichst zu entfernen, sind doch
noch Objekte vorhanden, die keine Höhenlinien darstellen. Beispielsweise sind dies Felsdar-
stellungen, Gletscherstrukturen, Wanderwege, Beschriftungen, Grenzlinien, Koordinatenlinien
oder schlicht und einfach Bildrauschen. Diese Objekte werden ebenfalls vektorisiert und müs-
sen danach manuell gelöscht werden. Sind unerwünschte Objekte in grosser Anzahl auf ein
kleines Gebiet beschränkt, wie in Abbildung 3.8 gezeigt, so lassen sich diese schnell und einfach
selektieren und löschen. Kleine Objekte lassen sich über eine gezielte Selektion, beschränkt
durch die maximale Linienlänge, finden und gegebenenfalls löschen. Dazu muss zuerst in der
Attributtabelle des entsprechenden Layers eine neue Spalte erstellt werden (→ Table Opti-
ons → Add Field), in welche die Länge der Features geschrieben wird (→ Rechtsklick auf
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Spaltenüberschrift → Calculate Geometry → Property: Length). Danach kann eine Selektion
ausgeführt werden (→ Selection → Select By Attributes). Viele unerwünschte Linienelemente
mussten allerdings einzeln von Hand gelöscht werden, da sie weder in grossen Gruppen auf-
traten, noch so klein waren, dass sie durch das Löschen mittels Selektion bereits eliminiert
worden wären. Dieses manuelle Löschen einzelner Objekte nahm einen Grossteil der Zeit in
Anspruch.

Abbildung 3.8.: Unerwünschte, vektorisierte Objekte in Form von Beschriftungen, Koordina-
tenlinien und Felszeichnungen.

Die drei Höhenlinienebenen, nun in vektorisierter Form, galt es in eine kohärente Ebene
zusammenzuführen. Probleme gab es an den Stellen, wo die Höhenlinien ihre Farbe wech-
seln. Die verschiedenen Farben wurden einzeln vektorisiert, weshalb die Enden der einzelnen
Teilstücke selten exakt aufeinandergepasst haben. Möglichst lange und zusammenhängende
vektorisierte Höhenlinien sind aber wünschenswert, da die Attribuierung dadurch massgeblich
vereinfacht wird. Es muss dann nicht mehr jedes einzelne Teilstück, sondern nur noch die gan-
ze zusammenhängende Höhenlinie attribuiert werden. Zuerst wurden also die Endpunkte der
Teilstücke aufeinandergelegt, was dank aktiviertem Snapping zwar einfach, aber zeitintensiv
war. Zudem wurden auch Teilstücke der gleichen Farbe bei Lücken, wie zum Beispiel in Ab-
bildung 3.6 zu sehen, verbunden. Danach wurden die Objekte der drei Ebenen in eine neue
Ebene verschoben. Die einzelnen Teilstücke waren nun zwar an den Enden deckungsgleich,
aber noch nicht zu einem einzigen Höhenlinienobjekt zusammengefügt. Mit dem Unsplit Line-
Tool (→ ArcToolbox → Data Management Tools → Features → Unsplit Line) wurde erreicht,
dass zwei Linien, die den selben Anfangs- beziehungsweise Endpunkt haben, zu einem Objekt
zusammengefasst wurden.

3.2.4. Koten

Die in der Karte eingetragenen Koten wurden zusätzlich in einem separaten Layer als Punkt-
objekte aufgenommen. Im Gegensatz zur Attribuierung der Höhenlinien erfolgte die Attribu-
ierung der Koten vollständig manuell und gleichzeitig mit der Digitalisierung.
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3.3. Attribuierung

Nach dem die Höhenlinien als Vektoren in ArcGIS vorlagen, galt es, diesen die dazugehörigen
Höhen in Form eines Attributes zuzuweisen. Bei der Bearbeitung des Untersuchungsgebietes
«Glacier de Moiry» erfolgte die Attribuierung vollständig manuell. Zum Zeitpunkt der Attri-
buierung der Höhenlinien des Untersuchungsgebietes «Turtmanngletscher» lag ein Tool von
Samuel Wiesmann für ESRI ArcGIS vor, das eine halbautomatische Bearbeitung ermög-
lichte. Nebst der Bereinigung der vektorisierten Höhenlinien ist dieser Arbeitsschritt wohl der
zeit- und arbeitsintensivste.

3.3.1. Manuell

Die manuelle Attribuierung ist aufwändig, aber relativ einfach zu bewerkstelligen. Es wird
die «Attribute Table» des Höhenlinienlayers geöffnet und eine weitere Spalte hinzugefügt, in
welche die Höhe geschrieben werden kann. Vorzugsweise wird im Hintergrund die Karte darge-
stellt. Nun kann eine vektorisierte Höhenlinie angewählt und die aus der Karte gelesene Höhe
in die «Attribute Table» eingetragen werden. Jede Höhenlinie muss dabei einzeln attribuiert
werden. Mit einiger Übung lässt sich dieser Prozess etwas beschleunigen. Es kann von Vor-
teil sein, zuerst die Zähllinien zu attribuieren, die bei der vorliegenden Landeskarte 1:50 000
mit einer Äquidistanz von 200 Meter eingetragen sind. Diese sind beschriftet und einfach zu
identifizieren. Bei der Attribuierung der nicht beschrifteten Haupthöhenlinien, die mit einer
Äquidistanz von 20 Meter vorliegen, besteht die Gefahr, dass man sich bei der Identifizierung
verrechnet. Auch vor Tippfehlern ist man nicht gefeit. Grobe Tippfehler, beispielsweise die
Eingabe von 23200 anstatt 2320 oder von 3320 anstatt 2320, wird man bei der Betrachtung
des später interpolierten Höhenmodells schnell an völlig unnatürlichen Spitzen erkennen. Ist
die Eingabe aber nur um 20 Meter falsch, wird es schwierig diesen Fehler aufzudecken, falls
kein Referenzhöhenmodell zur Verfügung steht.

3.3.2. Halbautomatisch

Das von Samuel Wiesmann entwickelte Tool «Contourline Attribution» musste zuerst in
die Toolbox hinzugefügt werden. Danach ist es, wie jedes andere Tool auch, in der Toolbox
abrufbar (→ ArcToolbox → Customized Tools → Contourline Attribution). Das Tool funktio-
niert folgendermassen: in einem weiteren Layer muss eine Hilfslinie erstellt werden, welche die
Höhenlinien schneidet, die beschriftet werden sollen. Die so erstelle Hilfslinie liegt also mehr
oder weniger in der Falllinie des Geländes (Abbildung 3.9). Die zu verwendenden Hilfslinien
müssen selektiert, sowie die Layer der Höhenlinien und der Hilfslinien im Tool angegeben wer-
den. Gleiches gilt für die Höhe der ersten zu attribuierenden Höhenlinie und die Äquidistanz.
Die Hilfslinie wird nun in kleine Teilintervalle unterteilt, deren Grösse im Feld «Parameter
helpline density control» festgelegt werden kann. Zuerst wird getestet, welche Höhenlinien mit
ihren Boundingboxen die Boundingbox der Hilfslinie schneiden. Das Ergebnis dieses Tests wird
in einem Hilfsattribut festgehalten. Nur diejenigen Linien, welche diese Bedingung erfüllen,
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Abbildung 3.9.: Hilfslinien (grün) und vektorisierte Höhenlinien (magenta) im Gebiet des
Turtmanngletschers.

werden weiter betrachtet. Danach erfolgt eine Prüfung, ob ein Teilintervall eine Höhenlinie
schneidet. Schneiden sie, so erhalten sie ein weiteres Attribut, das angibt, welches Teilinter-
vall der Hilfslinie betroffen ist. Die Teilintervalle der Hilfslinie sind vom Anfang bis zum Ende
durchnummeriert. So kann die Reihenfolge der zu beschriftenden Höhenlinien festgelegt und
ihnen die Höhe zugewiesen werden. Optional kann zusätzlich die Höhe der letzten Höhenlinie
angegeben werden, die automatisch attribuiert werden soll. Stimmt diese Höhe nicht mit der
vom Algorithmus berechneten Höhe überein, so wird die Ausführung des Tools abgebrochen.
Des Weiteren kann es, beispielsweise in steilem Gelände, vorkommen, dass die Grösse der
Teilintervalle zu gross gewählt wird, und in einem Teilintervall mehrere Höhenlinien die Hilfs-
linie schneiden. Auch dann wird die Ausführung des Tools mit entsprechender Fehlermeldung
abgebrochen.
Das Tool kann besonders bei leistungsschwachen Computern relativ langsam arbeiten. We-

sentlich ist dann, dass man die Hilfslinie geschickt platziert, so dass die Boundingbox der
Hilfslinie möglichst klein ist und wenn möglich nur die Höhenlinien beinhaltet, die attribuiert
werden sollen. Das Tool ist aber auch bei schlechter Performance von Vorteil, da Tipp- und
Zählfehler vermieden werden können.

3.4. DHM-Generierung

Im Arbeitsschritt zur DHM-Generierung erfolgte die Interpolation eines Höhenmodells auf
Basis der vektorisierten und attribuierten Höhenlinien sowie den ebenfalls digitalisierten Hö-
henkoten. Die Abbildungen A.5 und A.6 im Anhang zeigen alle für die beiden DHM benutzten
Höhenlinien und Koten. Für das Gebiet des Turtmanngletschers wurde auch aus den LIDAR-
Rohdaten ein DHM generiert.
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3.4.1. DHM-Generierung mit «Topo to Raster» in ESRI ArcGIS

Die Generierung eines DHM mit ESRI ArcGIS ist auf den ersten Blick ein Leichtes. Mit dem
Tool «Topo to Raster» (→ ArcToolbox → 3D Analyst Tools → Raster Interpolation → Topo
to Raster) können die für die Interpolation nötigen Features und Parameter ausgewählt wer-
den. Mit einem Klick wird das DHM interpoliert. Doch was im Hintergrund dabei abläuft, ist
komplex. Der im genannten Tool verwendete Algorithmus basiert massgebend (ESRI, 2011c)
auf der Interpolationsmethode des ANUDEM (Australian National University Digital Ele-
vation Model) von Hutchinson (1989). ANUDEM liegt momentan in Version 5.2 vor und
wurde unteranderem zur Interpolation des «GEODATA 9 Second Digital Elevation Model
(DEM-9S)», einem DHM von ganz Australien, das von der Fenner School of Environment
and Society an der Australian National University und von Geoscience Australia entwickelt
und produziert wurde, verwendet (Hutchinson, 2009). Das Topo to Raster-Tool in ArcGIS
10.0 SP1 basiert allerdings auf der älteren ANUDEM Version 4.6.3 (ESRI, 2011a). Der Al-
gorithmus wurde speziell für hydrologische Zwecke entwickelt und ist fähig, mit grossen und
inhomogenen Datenmengen umzugehen. Als Input-Daten sind neben einigen anderen vor al-
lem Punkthöhen, Konturlinien und Bruchkanten vorgesehen. Der Algorithmus wird als robust
beschrieben und entfernt automatisch falsche Senken und Kuppen (Hutchinson, 2009). Aus
Zeitgründen erfolgte im Verlaufe dieser Bachelorarbeit keine vertiefte Betrachtung dieser und
anderer Interpolationsmethoden. Für Detailangaben sei daher auf die genannten Quellen ver-
wiesen. Die Interpolation erfolgte vornehmlich mit den Standardwerten für die verschiedenen
Parameter. Bei der Angabe der Input Features ist darauf zu achten, dass das entsprechende
Feld und der Typ der Höheninformation korrekt gewählt werden. Für die Output-Zellgrösse
wurden 25 Meter gewählt, da das DHM25 von swisstopo sowie das DHM der VAW beim Gla-
cier de Moiry ebenfalls als 25 Meter Raster vorlagen und so ein optimaler Vergleich möglich
war. Zur Visualisierung wurden aber auch DHM mit kleineren Zellgrössen berechnet. Unter
«Primary typ of input data» wurde «Contour» gewählt. Alle anderen Parameter wurden bei
den Standardwerten belassen.

3.4.2. DHM-Generierung aus LIDAR-Daten mit ESRI ArcGIS

Aus den als Punktwolke vorliegenden LIDAR-Daten wurden mit dem Point to Raster-Tool
(→ ArcToolbox → Conversion Tools→ To Raster→ Point to Raster) ein Raster-Höhenmodell
erzeugt. Der Wert für die Zellgrösse wurde für Vergleiche mit anderen DHM auf 25 Meter ge-
setzt. Es wurden aber auch zwei DHM mit einer kleineren Zellgrösse von zwei beziehungsweise
fünf Meter generiert, die zur 3D-Visualisierung mit ArcScene dienten. Bei der Auswahl «Va-
lue Field» wurde die Höhe der Punkte, also «Shape.Z» gewählt. Die Höhe der einzelnen Zelle
wurde als Mittelwert der Höhen aller in der Zelle liegenden Punkte bestimmt. Der Parameter
«Priority field» wird in Verbindung mit der Auswahl des Mittelwerts des «Cell assignment
type» nicht verwendet. Bei den DHM mit fünf oder einem Meter Zellgrösse traten vereinzelt
Lücken auf, da dort offensichtlich keine Daten vorhanden waren. Gut als Lücken im DHM zu
sehen, sind bei allen DHM aus den LIDAR-Daten die kleinen Seen bei der Gletscherzunge des
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Turtmanngletschers. Da die Laserimpulse vom Wasser nur schlecht oder gar nicht reflektiert
werden, sind dort keine Höhendaten vorhanden.

3.5. Differenzen zweier DHM

Die Differenzen zwischen zwei DHM wurden mit der Minus-Funktion gebildet (→ ArcToolbox
→ 3D Analyst Tools → Raster Math → Minus). Es sollte darauf geachtet werden, dass die
Zellgrössen der beiden Raster-DHM gleich gross sind. Sind diese nicht gleich gross, können
systematische Effekte entstehen, die das Bild verfälschen. In dieser Arbeit wurden Differenzen
stets in 25 Meter Rastern berechnet. Durch das Anwenden der Minus-Funktion wird für jede
Zelle eine Differenz bestimmt. Die mittlere Differenz sowie die Volumendifferenz, die sich zu
∆V = A ·

∑
∆di mit der Zellfläche A und der Differenz einer Zelle ∆di berechnet, hängen von

der Zellgrösse ab. Kleinere Zellgrössen liefern aber nicht unbedingt das genauere und zuverläs-
sigere Resultat, da die Raster-DHM durch Interpolation generiert wurden. Entscheidend ist
die Dichte der Höheninformationen, die bei der Generierung des DHM zur Verfügung stehen.
Je dichter diese sind, desto kleiner kann die Zellgrösse des DHM gewählt werden.

3.6. Visualisierung

Der letzte Arbeitsschritt bildete die Visualisierung der interpolierten Höhenmodelle. Zudem
wurden für die beiden Gebiete die Differenzen zwischen den in dieser Arbeit generierten DHM
und den weiteren zur Verfügung stehenden DHM berechnet und visualisiert.

3.6.1. In ESRI ArcGIS

Zweidimensionale Kartendarstellungen sind in ArcMap leicht und mit wenig Aufwand zu er-
zeugen. Die Darstellungsreihenfolge der verschiedenen Ebenen kann beliebig verändert werden.
Als Basiskarte im Hintergrund eignen sich sowohl die Karten der Erstausgabe der Schweizer
Landeskarte oder auch die aktuellen Pixelkarten. Um die Informationsdichte zu erhöhen, kön-
nen die Ebenen auch transparent dargestellt werden. Eine solche Darstellungen findet sich
beispielsweise in der bereits gezeigten Abbildunge 3.9 auf Seite 26. Müssen die Visualisierun-
gen aber auch kartografischen Aspekten genügen, so sollte die Darstellung zumindest in der
Layout-View in ArcMap mit weiteren Angaben, wie Titel, Legende oder Massstab ergänzt
werden. Oft ist aber auch dann noch eine Weiterverarbeitung mit einer Desktop-Publishing-
Software notwendig.
Zur zweidimensionalen Darstellung der DHM wurde auch die Geländeschummerung verwen-

det. Die Hillshade-Funktion in ArcMap (→ ArcToolbox → Spatial Analyst Tools → Surface
→ Hillshade) generiert Geländeschummerungen für Raster-Daten unter Berücksichtigung des
Azimuts und der Höhe der Lichtquelle. Wie es sich der Leser von den Schweizer Landeskarten
gewohnt ist, wurde eine Beleuchtung von «oben links», mit einem Azimut von 315° und einer
Höhe von 45° gewählt. Es entsteht so ein in Abbildung 3.10 gezeigter, plastischer Eindruck
des Geländes.
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Abbildung 3.10.: Geländeschummerung des DHM25 im Gebiet des Glacier de Moiry.

Auch das Generieren von Höhenlinien (→ ArcToolbox → Spatial Analyst Tools → Surface
→ Contour) ist möglich. Diese Visualisierung wurde in diesem Fall zur Kontrolle erstellt,
da die Eingabegrössen der Interpolation des DHM ja selbst Höhenlinien sind. Bei einer per-
fekten Verarbeitung der Eingangsdaten müssten also die identischen Höhenlinien resultieren.
Auf Grund der Interpolation und möglichen Ungenauigkeiten und Fehlern bei der Vektori-
sierung und Attribuierung wird dies aber nie der Fall sein. Die Abbildung 3.11 zeigt diesen
Umstand. Die Visualisierung der Differenzen zwischen zwei DHM erfolgte mittels Farben. Die
Differenzen wurden klassiert und den Klassen entsprechende Farben zugeteilt. Diesbezügliche
Abbildungen finden sich in Kapitel 4. Zu Visualisierungszwecken standen auch acht Orthopho-
tokacheln zur Verfügung, welche zuerst zu einem Orthophotomosaik zusammengefügt wurden
(→ ArcToolbox → Data Management Tools → Raster → Raster Dataset → Mosaic To New
Raster). Leider wurden nicht alle Photos zum selben Zeitpunkt aufgenommen, wie unschwer
in Abbildung B.1 im Anhang erkannt werden kann. Das eigentlich qualitativ hochstehende
Orthophotomosaik wurde daher nicht in dem Masse zur Visualisierung genutzt, wie es möglich
wäre, da die Inhomogenität des Bildes den Eindruck zu sehr stört.
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Abbildung 3.11.: Aus dem generierten DHM mit 25 Meter Zellgrösse abgeleitete Höhenlinien
(braun) im Vergleich mit der Grundlagenkarte.

Mit ArcScene des ArcGIS-Paketes lassen sich auch dreidimensionale Darstellungen erzeu-
gen. Dazu werden die gewünschten Layer in ArcScene geladen. Um einen Layer dreidimensio-
nal darstellen zu können, muss eine Quelle für die Höhenangaben gewählt werden (→ Layer
Properties → Base Heights → Elevation from surfaces → Floating on a custom surface).
Zudem kann es wichtig sein, die Art des Resamplings (→ Layer Properties → Display →
Resample during display using) anzupassen. Es bieten sich die bilineare Interpolation oder
«Cubic Convolution» an. Weitere Einstellungen sind unter dem Reiter «Rendering» möglich,
wo sich beispielsweise die Qualität der Texturen oder Schatteneffekte einstellen lassen. Auch
in ArcScene ist es möglich, mehrere Ebenen gleichzeitig und transparent darzustellen. Zu Pro-
blemen kann es mit der Darstellung von Polygon-Shape-Files kommen. Die Umrandung wird
zwar korrekt dargestellt, der Flächeninhalt aber liegt nicht auf dem DHM auf. Das Generieren
von virtuellen Flügen durch die Landschaft wäre in ArcScene ebenfalls möglich, was aber im
Verlaufe dieser Arbeit nicht gemacht wurde.

Abbildung 3.12.: Darstellungsprobleme mit Polygon-Shape-Files auf einem Raster-DHM.

3.6.2. 3D-PDF

Im Verlauf der Arbeit entstand die Idee, die generierten DHM auch als 3D-PDF festzuhalten.
Dieses Dateiformat eignet sich hervorragend zur Weitergabe eines visualisierten digitalen 3D-
Modells, da es vom weit verbreiteten Adobe Reader ab Version 8.1 und somit von praktisch
jedermann gelesen werden kann. Im Gegensatz dazu steht das langsam in die Jahre gekommene
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Abbildung 3.13.: Benutzeroberfläche von Right Hemisphere Deep Exploration 5.7 mit dem
DHM aus LIDAR-Daten des Turtmanngletschers und einem Orthophoto.

VRML-Format, das ESRI ArcScene für den Export von Daten anbietet und spezielle Software
voraussetzt, um die Datei öffnen zu können.
Für das Erstellen eines 3D-PDF wird eine Software benötigt, die einerseits das VRML-

Dateiformat lesen und andererseits das U3D-Dateiformat ausgeben kann. Das U3D-Dateiformat
ist wie VRML ein Dateiformat für 3D-Daten, allerdings moderner und von der European
Computer Manufacturers Association ECMA im Jahr 2005 zum ECMA-363 Standard erklärt
worden (ECMA, 2007). Viele CAD-Softwarepakete bieten diese Funktionen. Im Zuge dieser
Arbeit wurde Deep Exploration in Version 5.7 von Right Hemisphere verwendet.
Die 3D-Szene wurde also in ArcScene als VRML-Datei exportiert und danach in Deep Ex-

ploration von Right Hemisphere geöffnet. Abbildung 3.13 zeigt die Arbeitsoberfläche von Deep
Exploration. Die Beleuchtung wurde leicht angepasst (→ Doppelklick auf die entsprechende
Lichtquelle) und danach das Projekt (→ Rechtsklick auf das geöffnete File → Batch Operati-
ons → Convert 3D Files) als U3D-Datei exportiert. In Adobe Acrobat konnte die U3D-Datei
geöffnet und als PDF abgespeichert werden.
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4. Resultate

Dieses Kapitel enthält Ausführungen zu den erzielten Ergebnissen. Dazu zählen die beiden
DHM des Glacier de Moiry beziehungsweise des Turtmanngletschers sowie die angestellten
Vergleiche mit weiteren DHM.

4.1. Untersuchungsgebiet «Glacier de Moiry»

Der Glacier de Moiry diente in dieser Arbeit als Testgebiet. Durch das gleichzeitig und nach
gleicher Methode erstelle DHM von Andreas Sidler und das bereits vorhandene DHM der
VAW, konnten einige Vergleiche zwischen den Resultaten der verschiedenen Autoren sowie den
zwei verschiedenen Digitalisierungsverfahren angestellt werden. Die hier gezeigten Vergleiche
beziehen sich alle auf die vom Autor definierte Gletscherfläche, die im Unterabschnitt 4.1.5
erwähnt wird.

4.1.1. Generiertes DHM

Das im Zuge dieser Arbeit erzeugte DHM mit einer Zellgrösse von 25 Meter stellt den Glacier
de Moiry auf Grundlage der Erstausgabe der Schweizer Landeskarte 1:50 000 dar. Der Glet-
scherstand des DHM datiert somit auf 1932. Das gesamte Gletschergebiet sowie ein gewisser
Korridor darum herum werden durch das DHM abgedeckt. An der VAW wurde auf Basis der
Stützpunkte der in dieser Arbeit digitalisierten Höhenlinien und Koten mit dem GTGRID 2.0
Algorithmus der Software PV-WAVE ein weiteres DHM interpoliert. Eine Darstellung dazu
ist in Abbildung A.7 im Anhang zu finden. Dieses DHM wurde allerdings im Rahmen dieser
Arbeit nicht weiter verwendet.

4.1.2. Vergleich mit DHM von Andreas Sidler

Berechnet wurden die Differenzen durch eine Subtraktion der DHM, wobei das DHM von
Andreas Sidler den Subtrahend bildete. Eine Kartendarstellung der Differenzen kann der
Abbildung A.9 im Anhang entnommen werden. Grössere Differenzen zeigen sich vor allem in
den Steilstufen des Glacier de Moiry. Dies kann dadurch erklärt werden, dass zwei verschie-
dene Strategien bei der Digitalisierung verwendet wurden. Bei der Digitalisierung des DHM
wurde vom Autor dieser Arbeit versucht, Höhenlinien möglichst auch in komplexen Gebieten
durchzuziehen. Andreas Sidler hat für sein DHM hingegen ausschliesslich eindeutig iden-
tifizierbare Höhenlinien verwendet. Die statistische Auswertung zeigt für das Gletschergebiet
eine mittlere Differenz von 34 Zentimeter bei einer Standardabweichung von 5.7 Meter. Dies
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bedeutet, dass das DHM von Andreas Sidler im Schnitt leicht tiefer liegt. Über 85% der
Differenzen liegen in einem Bereich von -5 bis +5 Meter.
Auf Grund der Unterschiede in den Steilstufen und auf Wunsch seitens der VAW wurde

für das DHM des Turtmanngletschers die Strategie von Andreas Sidler verfolgt und nur
Höhenlinien digitalisiert, die eindeutig als solche identifiziert werden konnten.

4.1.3. Vergleich mit DHM der VAW

Das DHM der VAW wurde sowohl mit dem DHM des Autors, als auch mit dem DHM von
Andreas Sidler verglichen. In den Abbildungen A.10 und A.11 im Anhang wurden die
Differenzen festgehalten. Für die Berechnungen diente das DHM der VAW jeweils als Minuend.
Das Mittel der Differenzen zwischen dem DHM des Autors und dem DHM der VAW beträgt
1.4 Meter bei einer Standardabweichung von 6.5 Meter. Im Falle des DHM von Andreas

Sidler beträgt die mittlere Abweichung 2.1 Meter bei einer Standardabweichung von 5.9
Meter. Für beide Vergleiche liegen jeweils rund 74% der Differenzen im Bereich zwischen ±5
Meter.

4.1.4. Vergleich mit DHM25

Der zeitliche Unterschied zwischen den beiden DHM beträgt 60 Jahre. Die Differenzen prä-
sentieren sich im Grossen und Ganzen so, wie man es erwarten würde. Die grössten Dicken-
verluste sind bei der Gletscherzunge auszumachen und betragen maximal 103 Meter, wie
Abbildung A.12 zu entnehmen ist. Das Mittel der Differenzen ist -12.6 Meter bei einer Stan-
dardabweichung von 17.1 Meter. Die Abbildung 4.1 vermittelt einen bildlichen Eindruck der
Veränderungen in der Periode zwischen 1932 und 1992.
Die auffallend grossen Differenzen, bis hin zu Zunahmen von knapp 46 Meter in den Randbe-

reichen des Gletschers, sind möglicherweise auf Lageunterschiede der beiden DHM zurückzu-
führen. In steilem Gelände kann eine Lagedifferenz von wenigen Metern bereits eine beträcht-
liche Höhendifferenz verursachen. Für die Differenzen im Akkumulationsgebiet des Gletschers
besteht bei einem Verlgeich mit dem DHM25 eine gewisse Unsicherheit. Gemäss Auskunft von
Andreas Bauder hat sich gezeigt, dass die Höheninformationen im DHM25 nicht immer
mit dem effektiv zu dieser Zeit vorliegenden Gletscherstand übereinstimmen. Grund dafür ist,
dass bei den Überarbeitungen der Kartenblätter, auf denen das DHM25 basiert, nicht jedes
Mal die komplette Gletscheroberfläche neu erfasst wurde. Oft wurden die Höhenkurven nur
im Zungenbereich angepasst.
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Abbildung 4.1.: Visualisierung des generierten DHM des Glacier de Moiry mit dem Glet-
scherstand von 1932 links und dem DHM25 mit Stand 1992 und überlagerter
Pixelkarte 50 von 2001 rechts.

4.1.5. Gletscherfläche

Auch die Fläche des Gletschers wurde auf Basis der Schweizer Landeskarte von 1946 von
allen drei Autoren ermittelt. Tabelle 4.1 zeigt die drei Resultate im Vergleich. Der Glacier
de Moiry wies demnach 1932 eine Fläche von knapp sieben Quadratkilometer auf. Die oben
beschriebenen Vergleiche zwischen den DHM beziehen sich jeweils auf die vom Autor definierte
und in Abbildung 4.2 dargestellte Gletscherfläche, die 11’139 Zellen der Grösse 25 x 25 Meter
enthält. Die Differenzen wurden jeweils für jede Zelle bestimmt.

Einheit Schenkel Sidler Bauder Mittelwert
[m2] 6958045 6968785 6943127 6956652
[km2] 6.958 6.969 6.943 6.957
[%] 100.00 100.15 99.79 99.98

Tabelle 4.1.: Von den drei Autoren aus der Erstausgabe der Schweizer Landeskarte von 1946
ermittelte Fläche des Glacier de Moiry.

4.1.6. Schlussfolgerungen

Wie a priori erwartet werden konnte, sind die Differenzen zwischen den beiden DHM, die
mit gleicher Methode generiert wurden, kleiner, als die Unterschiede zum DHM der VAW,
das vollständig manuell digitalisiert und mit einem anderen Algorithmus interpoliert wurde.
Werden dieselbe Methode, Interpolation und Strategie bei der Digitalisierung verwendet, so
unterliegen die Differenzen zwischen den DHM zweier Autoren wahrscheinlich nur dem Zufall.
Ein grober Fehler im generierten DHM, beispielsweise verursacht durch eine falsch attribu-
ierte Höhenlinie, kann durch die Vergleiche mit den DHM von Andreas Sidler und der
VAW praktisch ausgeschlossen werden. Es kann nicht abschliessend beurteilt werden, ob ein
signifikanter Genauigkeitsunterschied zwischen den drei verschiedenen DHM beziehungswei-
se zwischen den zwei Digitalisierungsmethoden besteht. Um dies zu klären, müssten weitere
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Abbildung 4.2.: Als Gletscherfläche definiertes Gebiet des Glacier de Moiry.

Höhenmodelle aus einer möglichst aktuellen Karte nach der vollständig manuellen Methode,
sowie der in dieser Arbeit verwendeten halb-automatischen Methode rekonstruiert und mit
Messungen im Feld verifiziert werden.

4.2. Untersuchungsgebiet «Turtmanngletscher»

Die Datenlage für den Turtmanngletscher gestaltete sich im Vergleich zum Glacier de Moiry
etwas anders, da in diesem Untersuchungsgebiet keine Vergleiche zwischen den verschiedenen
Methoden und Autoren durchgeführt wurden. Die Resultate zum generierten DHM sowie zu
den Vergleichen mit den DHM neueren Datums werden in diesem Kapitel beschrieben. Die
Differenzen beziehen sich auf die in Abbildung 4.3 dargestellte, vom Autor definierte und von
der VAW als korrekt eingestufte Gletscherfläche. Sie entspricht nicht den zusammenhängenden
Eismassen, sondern dem hydrologischen Einzugsgebiet der Turtmänna, also dem Fluss, der
dem Turtmanngletscher entspringt.

Roland Schenkel 35



ETH Zürich Kapitel 4. Resultate

Abbildung 4.3.: Als Gletscherfläche definiertes Gebiet des Turtmanngletschers.

4.2.1. Generiertes DHM

Das im Verlaufe dieser Arbeit generierte DHM des Turtmanngletschers weist eine Zellengrösse
von 25 Meter auf und basiert auf der Erstausgabe der Schweizer Landeskarte 1:50 000 mit
Gletscherstand 1931. Das DHM deckt eine Fläche von etwa 56 Quadratkilometern ab und
umfasst nebst dem Turtmann- und Brunegggletscher auch den Pipji-, den Brändji- und den
Diablonsgletscher vollständig. Teile des Glacier duWeisshorn, des Bisgletschers, des Obere und
Undere Stelligletschers sowie des Junggletschers sind ebenfalls im DHM enthalten. Vergleiche
zu anderen DHM wurden allerdings nur für den Turtmann- und Brunegggletscher angestellt.
Analog zum Glacier de Moiry wurde auch für dieses Untersuchungsgebiet ein weiteres DHM
an der VAW erstellt. Dieses basiert auf den Stützpunkten der digitalisierten Höhenlinien
sowie den Koten und wurde mit dem GTGRID 2.0 Algorithmus der Software PV-WAVE
interpoliert. Eine Darstellung dazu ist in Abbildung A.8 im Anhang zu finden. Dieses DHM
wurde im Rahmen dieser Arbeit nicht weiter verwendet.

4.2.2. Vergleich mit dem DHM25

Das DHM25 im Gebiet des Turtmanngletschers weist einen Gletscherstand je nach Gebiet
von 1992, 1993 oder 1995 auf. Vergleicht man das auf der Erstausgabe der Landeskarte ba-
sierende DHM mit dem DHM25, so liegt ein zeitlicher Unterschied von 61 bis 64 Jahren vor.
Die berechneten Differenzen können der Abbildung A.13 im Anhang entnommen werden. Im
Mittel betragen sie -13.2 Meter bei einer Standardabweichung von 14.5 Metern. Der maximale
Dickenverlust beträgt knapp 103 Meter. Wie zu erwarten war, sind die Differenzen bei der
Gletscherzunge und im unteren Teil des Gletschers am grössten. Die Unterschiede im Bereich
des Turtmanngletschers zeigt Abbildung 4.4, die des Pipjigletschers Abbildung 4.5 und die
des Diablonsgletscher Abbildung 4.6.
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Abbildung 4.4.: Visualisierung des generierten DHM des Turtmanngletschers mit dem Glet-
scherstand von 1931 links und dem DHM25 und überlagerter Pixelkarte 50
rechts.

Abbildung 4.5.: Visualisierung des generierten DHM des Pipjigletschers mit dem Gletscher-
stand von 1931 links und dem DHM25 und überlagerter Pixelkarte 50 rechts.
Der Pipjigletscher ist im Bild rechts praktisch nicht mehr zu sehen.

Abbildung 4.6.: Visualisierung des generierten DHM des Diablonsgletschers mit dem Glet-
scherstand von 1931 links und dem DHM25 und überlagerter Pixelkarte 50
rechts.

Roland Schenkel 37



ETH Zürich Kapitel 4. Resultate

4.2.3. Vergleich mit dem DHM aus LIDAR-Daten

Ein weiterer Vergleich wurde mit dem DHM aus LIDAR-Daten angestellt, welches einen Glet-
scherstand von 2005 aufweist. Der zeitliche Unterschiede der beiden DHM beträgt also 74 Jah-
re. Wie in der Abbildung A.14 im Anhang vermerkt, beträgt das Mittel der Differenzen rund
-19 Meter mit einer Standardabweichung von 18.4 Meter. Wie erwartet, sind die Differenzen
deutlich grösser als im Vergleich mit dem DHM25.

4.2.4. Vergleich zwischen dem DHM25 und dem DHM aus LIDAR-Daten

Interessant sind auch die Differenzen zwischen dem DHM25 und dem LIDAR-DHM. In die
Zeitdauer von 10 bis 13 Jahre zwischen diesen beiden Gletscherständen fällt auch der Hit-
zesommer 2003. Das Mittel der in Abbildung A.15 festgehaltenen Differenzen beträgt -5.7
Meter bei einer Standardabweichung von 9.1 Meter. Auffällig ist die Hebung des Geländes
im Norden. Die Differenzen wurden ebenfalls im zuvor definierten Gletschergebiet von 1931
berechnet. Allerdings hat sich in der Zwischenzeit der Gletscher soweit zurückgezogen, dass
im angesprochenen Bereich nicht die Veränderung der Mächtigkeit des Gletschers sondern die
Höhenveränderung des Geländes berechnet wurde. Die Hebung lässt sich eventuell durch eine
Rückhalteeinrichtung für Geschiebe erklären, die in diesem Bereich errichtet wurde, um den
gleich unterhalb liegenden Stausee vor der Verlandung zu schützen.

4.2.5. Schlussfolgerungen

Die berechneten Differenzen entsprechen insofern den Erwartungen, als dass sie besonders in
den tiefliegenden Bereichen des Gletschers gross sind. Auch dass die Höhendifferenzen für die
Zeitspanne von 74 Jahren grösser ausfallen, als diejenigen für den zeitlichen Abstand von 61
bis 64 Jahren entspricht den Erwartungen. Die Resultate sind in diesem Sinne plausibel.

4.3. 3D-PDF

Die Möglichkeit 3D-Modelle im bekannten PDF-Format zu speichern und weiterzugeben ist
für viele Belange zweckmässig. Anzumerken ist an dieser Stelle, dass es möglich ist, mehrere
Layer gleichzeitig in einem 3D-PDF zu speichern und diese dann beim Betrachten in Adobe
Reader oder Adobe Acrobat einzeln aus- und einzuschalten. Den Layern können auch verschie-
dene DHM zu Grunde liegen. Werden die Standardeinstellungen bei Import und Export in
Right Hemisphere Deep Exploration und Adobe Acrobat verwendet, so erreicht ein 3D-PDF
eine erstaunlich kleine Dateigrösse. Als Beispiel sei hier das 3D-PDF des Turtmanngletschers
mit einem Layer, der Landeskarte von 1946 auf dem daraus generierten DHM mit 20 Meter
Zellgrösse, genannt. Es weist eine Dateigrösse von lediglich 5 MB bei einer qualitativ hochwer-
tigen Darstellung auf. Wahlweise können in Deep Exploration die Texturen der Layer anstatt
im JPEG- auch im PNG-Format exportiert werden. Die Dateigrösse wird dadurch mit 26 MB
rund verfünffacht. Die Qualität der Texturen wird dafür nochmals etwas besser.
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Die Layer, welche die Veränderungen der Mächtigkeit der Gletscher farblich darstellen,
konnten nur mangelhaft in das 3D-PDF integriert werden. Die transparenten Bereiche wurden
schwarz eingefärbt, was störend ist. Möglicherweise wären Anpassungen der Texturen in Deep
Exploration nötig, um dieses Problem zu lösen. Ein weiteres Problem trat beim Export des
selbst generierten DHM des Glacier de Moiry aus ArcScene auf. Der Export führte stets zum
sofortigen Absturz von ArcScene, ohne eine Fehlermeldung zu generieren. Als 3D-Modell für
die Darstellung der Schweizer Landeskarte von 1946 im 3D-PDF diente daher das DHM25
von swisstopo.
Zum Schluss kann gesagt werden, dass das Potential, welches eine CAD-Software wie Deep

Exploration bietet, im Zuge dieser Bachelorarbeit bei Weitem nicht ausgeschöpft wurde. Dazu
wäre eine vertiefte Einarbeitung in die Software von Nöten.
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5. Schlussbemerkungen

Im letzten Kapitel wird ein abschliessendes Fazit zum Vorgehen gezogen, die Zielerreichung
festgehalten und Möglichkeiten für weitere Arbeiten im Zusammenhang mit Gletscher-
Höhenmodellen vorgeschlagen.

5.1. Schlussfolgerungen

Das gewählte Vorgehen ist adäquat und zielführend. Es kann damit innert nützlicher Frist ein
digitales Höhenmodell eines Gletschergebietes erzeugt werden. Verbesserungen der einzelnen
Arbeitsschritte sind aber noch möglich.
Die Höhenlinienextraktion könnte möglicherweise mit Kantendetektoren und weiteren Al-

gorithmen, beispielsweise mit Hilfe der Image Processing Toolbox von Matlab, weiter auto-
matisiert und verbessert werden. Die Methode der Farbseparation ist vor allem für die blauen
und braunen Höhenlinien sehr gut geeignet, da in diesen Farbebenen nebst den Höhenlini-
en nur wenige andere Objekte abgebildet sind. Entsprechend schnell und einfach gestaltet
sich demnach die Bereinigung vor oder nach der Vektorisierung in diesen beiden Ebenen. Die
schwarze Farbebene enthält nebst den Höhenlinien in grossem Masse weitere Objekte, die mit
dem gewählten Vorgehen nach der Vektorisierung manuell entfernt werden müssen. Soll nicht
nur ein Höhenmodell des Gletschers, sondern auch eines grösseren Gebietes um den Gletscher
herum generiert werden, ist für die Bereinigung genügend Zeit einzuplanen.
Der langwierigste und aufwändigste Arbeitsschritt stellt die Bereinigung der vektorisier-

ten Daten dar. Nebst der bereits angesprochenen Entfernung unerwünschter Objekte, müssen
Lücken zwischen Höhenlinienstücken geschlossen werden, um möglichst lange Höhenlinien zu
erhalten. Das Attribuieren kann dadurch massgebend vereinfacht werden. Da die Vektorisie-
rung in jeder der drei Farbebenen einzeln durchgeführt wird, ist es auch an den Farbüber-
gängen der Höhenlinien nötig, eine lückenlose Verbindung der Höhenlinien sicherzustellen.
Durch Verbesserung und Beschleunigung dieses Arbeitsschrittes wäre beim gewählten Vorge-
hen wahrscheinlich am meisten Zeitgewinn zu erzielen.
Dank dem Contourline Attribution-Tool von Samuel Wiesmann ist eine effizienten At-

tribuierung der Höhenlinien möglich. Dank des Tools können Tippfehler auf ein Minimum
reduziert, Zählfehler sogar ganz ausgeschlossen werden. Die Performance des Tools könnte
möglicherweise noch verbessert werden, was aber nur für leistungsschwache Rechner von Be-
deutung ist.
Zur DHM-Generierung lässt sich bemerken, dass die Interpolation mit dem Topo to Raster-

Tool schnell und einfach zu bewerkstelligen ist. Um zwei DHM miteinander zu vergleichen,
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sollten sie möglichst mit dem selben Algorithmus interpoliert werden. Dadurch können sys-
tematische Abweichung auf Grund unterschiedlicher Algorithmen vermieden werden. In der
vorliegenden Arbeit war das nur teilweise möglich. Für Vergleiche zweier DHM wird im Rah-
men des Projekts der VAW aber immer dieselbe Interpolationsmethode verwendet.

5.2. Zielerreichung

Das Primärziel, die digitale Rekonstruktion und Visualisierung des Turtmanngletschers auf
Basis der Erstausgabe der Schweizer Landeskarte 1:50 000, wurde erreicht. Mit der Rekon-
struktion des Glacier de Moiry, dem Berechnen der Differenzen zwischen den verschiedenen
DHM der Untersuchungsgebiete und der Visualisierung der Resultate wurden auch sämtliche
Teilziele erfüllt.

5.3. Ausblick

Wie bereits in den Schlussfolgerungen angetönt, bietet das Vorgehen durchaus Verbesserungs-
potential. So wäre eine Verbesserung und Automatisierung der Höhenlinienextraktion wün-
schenswert. Vor allem dann, wenn im Gebiet viele schwarze Höhenlinien auftreten. Die Be-
reinigung der vektorisierten Daten bietet ebenfalls Potential zur weiteren Beschäftigung. Das
Löschen unerwünschter Objekte kann vermutlich nur schwer automatisiert werden, da die
automatische Erkennung und Unterscheidung von erwünschten und unerwünschten Objek-
ten wohl schwierig zu bewerkstelligen ist. Das automatische Schliessen von Lücken zwischen
Höhenlinien ist vermutlich eher realisierbar.
Im Bezug auf die generierten DHM wären weitere Untersuchungen möglich. Beispielsweise

bezüglich dem nötigen Zeitaufwand für die hier gewählte Methode im Vergleich zur vollstän-
dig manuellen Methode der VAW. Interessant wären auch Vergleiche zwischen verschiedenen
Interpolationsalgorithmen sowie Untersuchungen zur Genauigkeit der interpolierten DHM.
Des Weiteren wäre die Visualisierung der Daten ausserhalb von ESRI ArcScene, beispiels-

weise in einem leistungsfähigen CAD-Programm, eine Möglichkeit zur vertieften Beschäfti-
gung.
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A. Kartendarstellungen

A.1. Schweizer Landeskarten

Abbildung A.1.: RGB Farbscan, Ausschnitt Blatt 283, Erstausgabe der Schweizer Landeskarte
1946, Massstab 1:50 000, Gletscherstand 1932 (swisstopo).
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Abbildung A.2.: Ausschnitt Blatt 283, Pixelkarte 50, Stand 2001, Massstab 1:50 000
(swisstopo)
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Abbildung A.3.: RGB Farbscan, Ausschnitt der Blätter 273, 274, 283, 284, Erstausgabe der
Schweizer Landeskarte 1941 (Bl. 274, 284) und 1946 (Bl. 273, 283), Massstab
1:50 000, Gletscherstand 1931 (swisstopo).
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Abbildung A.4.: Ausschnitt der Blätter 273, 274, 283, 284, Pixelkarte 50, Stand 2001 (Bl. 283,
284), 2004 (Bl. 273) und 2005 (Bl. 274), Massstab 1:50 000 (swisstopo).
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A.2. Digitalisierte Höhenlinien und Koten

Abbildung A.5.: Abbildung der rund 1050 Höhenlinien und 53 Koten, die für die Interpolation
des DHM des Glacier de Moiry benutzt wurden.
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Abbildung A.6.: Abbildung der rund 2400 Höhenlinien und 113 Koten, die für die Interpola-
tion des DHM des Turtmanngletschers benutzt wurden.
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A.3. Höhenlinien aus den DHM

Abbildung A.7.: Höhenlinien des DHM des Glacier de Moiry, das von der VAW mit dem GT-
GRID 2.0 Algorithmus durch die Stützpunkte der digitalisierten Höhenlinien
und Koten interpoliert wurde. Gletscherstand: 1932.
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Abbildung A.8.: Höhenlinien des DHM des Turtmanngletschers, das von der VAW mit dem
GTGRID 2.0 Algorithmus durch die Stützpunkte der digitalisierten Höhen-
linien und Koten interpoliert wurde. Gletscherstand: 1931.
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A.4. Differenzen der DHM, Glacier de Moiry

Abbildung A.9.: Kartendarstellung der Differenzen zwischen den DHM von Andreas Sidler
und Roland Schenkel, die mit dem gleichen Verfahren generiert wurden.
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Abbildung A.10.: Kartendarstellung der Differenzen zwischen den DHM von Roland Schenkel
und der VAW, die mit unterschiedlichen Verfahren generiert wurden.

Roland Schenkel 54



ETH Zürich Anhang A. Kartendarstellungen

Abbildung A.11.: Kartendarstellung der Differenzen zwischen den DHM von Andreas Sidler
und der VAW, die mit unterschiedlichen Verfahren generiert wurden.
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Abbildung A.12.: Kartendarstellung der Differenzen zwischen dem DHM von Roland Schenkel
und dem DHM25. Zeitliche Differenz: 60 Jahre.

Roland Schenkel 56



ETH Zürich Anhang A. Kartendarstellungen

A.5. Differenzen der DHM, Turtmanngletscher

Abbildung A.13.: Kartendarstellung der Differenzen zwischen dem DHM von Roland Schenkel
und dem DHM25. Zeitliche Differenz: zwischen 61 und 64 Jahren.
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Abbildung A.14.: Kartendarstellung der Differenzen zwischen dem DHM von Roland Schenkel
und dem DHM aus LIDAR-Daten. Zeitliche Differenz: 75 Jahre.
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Abbildung A.15.: Kartendarstellung der Differenzen zwischen dem DHM25 und dem DHM
aus LIDAR-Daten. Zeitliche Differenz: zwischen 10 und 13 Jahren.
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B. Orthophoto

B.1. Turtmanngletscher

Abbildung B.1.: Orthophotomosaik des Turtmanngletschers aus Bildern zwischen 2006 und
2008 von swisstopo.
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